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1 Introduction

1.1 Overview

MQCCI-GUI application allows the user to create or update MQCCI IniFiles.  MQCCI-GUI can run 
on any platform that supports Java v1.6 (or higher): Linux, Mac OS X, and Windows Vista/7/8/8.1/10. 

MQ Channel Connection Inspector (MQCCI) is a solution that allows a company to track and/or audit 
what information a client application or remote queue manager is exchanging with the local queue 
manager when a connection is made.

MQCCI is comprised of an MQ Channel Security Exit. A channel security exit is ONLY 
invoked/called by the queue manager's MCA (Message Channel Agent) for MQCONN/X and 
MQDISC API calls (so it is very light-weight).

MQCCI will operate with IBM MQ v7.1, v7.5, v8.0, v9.0, v9.1 and v9.2 in Windows, Unix, IBM i and
Linux environments. It works with Server Connection, Receiver, Requester, Sender, Server, Cluster-
Sender and Cluster-Receiver channels of IBM MQ queue manager.

MQCCI is designed to provide the MQAdmin with any or all of the fields of the MQCD and MQCXP 
structures in a "human readable" format.  Human readable implies that it will convert binary fields into
their MQ defined names (i.e. SSLClientAuth=MQSCA_REQUIRED).  The user can control the fields 
that are outputted for each of the following MQ structures: MQCD and MQCXP.

MQCCI is designed to output 1 line per API call (1 long line).  The output information is written to 
plain text CSV (Comma Separate Value) files.  The user can choose to have the output information 
written to a local or remote queue rather than to a file.  

On IBM i, Linux, Unix and Windows, MQCCI can be configured and used with a non-default 
installation of MQ in a multi-install MQ environment.
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2 Installation
This chapter will describe the installation and configuration (optional) of MQCCI-GUI. For Windows 
users, the installation of MQCCI-GUI is very simple and straightforward. For other Operating 
Systems, it is necessary to unzip the software package.

2.1 Prerequisites
This section lists the required hardware and software components needed to run the MQCCI-GUI 
application. 

2.2 Software
The following third party software components must be installed in order to properly run MQCCI-
GUI: 

 Java Runtime Environment (JRE) 1.6 (or higher) or Java 2 SDK, Standard Edition (J2SE) v1.6 
(or higher) 

2.3 Hardware / OS
MQCCI-GUI is capable of running on the following hardware platforms that support Java v1.6 (or 
higher): 

 Linux
 Mac OS X
 Windows Vista, 7, 8, 8.1 & 10

2.4 Setting Up and Running the Application
The following section provides instructions on installing and running the MQCCI-GUI application.

2.4.1 For Windows Users:

 Run the install program called: mqccigui-setup-withjre.exe 

 The installer should follow the standard Windows install procedures and provide default values
for the users. 

 When the install program has installed MQCCI-GUI, there will be a newly created folder under
Start -> All Programs called MQCCI-GUI. 

 To run MQCCI-GUI, select the MQCCI-GUI icon from within the MQCCI-GUI folder. 
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2.4.2 For Linux and Max OS X (requires JRE/JDK):

 MQCCI-GUI is provided as a zip file: mqccigui.zip 

 To unzip the file, open a shell prompt and execute the following commands: 

unzip mqccigui.zip 

 When the unzip command has finished, there should be a directory tree as follows: 

Capitalware/MQCCI-GUI 

 Change directory by typing the following:

cd Capitalware/MQCCI-GUI 

 Before running MQCCI-GUI for the first time, you need to add the execute attribute to the 
mqccigui.sh shell scripts. Type the following: 

chmod +x mqccigui.sh 

 To run MQCCI-GUI from the Capitalware/MQCCI-GUI directory, then type the following: 

./mqccigui.sh 
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3 Creating or Updating IniFiles
This chapter will describe the how to create or update IniFiles.

3.1 New IniFile
This section will describe how to create a new MQCCI IniFile. The IniFile can be for a local or remote
MQCCI implementation. 

From the main menu of MQCCI-GUI, select File then New File 

The following is the New IniFile panel: 

Fill in the following information: 
 Input a file name including the file extension of '.ini'
 Select the Operating System
 Choose between a 32-bit or 64-bit environment

Finally, click the Ok button to create and open the new MQCCI IniFile.
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3.2 Open an IniFile
This section will describe how to open a MQCCI IniFile to be viewed or edited. The IniFile can be for 
a local or remote MQCCI implementation. 

From the main menu of MQCCI-GUI, select File then Open File 

The following is the Open dialog box: 

Select the IniFile that you wish to view or edit and then click the Open button.
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3.3 Close an IniFile
This section will describe how to close a MQCCI IniFile. 

From the main menu of MQCCI-GUI, select File then Close 

If the user has altered the IniFile then the user will be presented with the following dialog box: 

Select Yes to save the changes; otherwise select No. 

The MQCCI-GUI program will make a backup of the original file in the same directory and call it: 
{inifilename}.backup
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3.4 Save IniFile
This section will describe how to save an open MQCCI IniFile. 

From the main menu of MQCCI-GUI, select File then Save 

The parameter information will be saved to the IniFile. 

The MQCCI-GUI program will make a backup of the original file in the same directory and call it: 
{inifilename}.backup
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3.5 Save As IniFile
This section will describe how to save an open MQCCI IniFile with a new file name. 
From the main menu of MQCCI-GUI, select File then Save As 

Select or input the IniFile name that you wish to use then click the Save button. 
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4 Tabs
This chapter will describe the various parameters on each tab.

4.1 General Tab
This section will describe various parameters on the General tab of a MQCCI IniFile. 
The following is a General Tab with default values: 
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The IniFile keywords and their values on the General Tab are discussed below.

4.1.1 General
This section describes the general keywords and their values.

 Active controls enabling or disabling MQCCI.

 Description parameter is optional and is not used by MQCCI.  It can be used to provide a brief 
description / purpose of the IniFile. 

 License key is provided by Capitalware Inc. The license is for a particular queue manager. 
Your license will look something like: 1000-AAAA-BBBBBBBB (Note: This is a sample license only 
and will NOT work). 

 LicenseFile specifies the location of License file that contains all of the customer's license 
keys.  The following are the default values for LicenseFile:

• For Windows: C:\Capitalware\MQCCI\mqcci_licenses.ini
• For IBM MQ 32-bit on Unix & Linux: /var/mqm/exits/mqcci_licenses.ini
• For IBM MQ 64-bit on Unix and Linux: /var/mqm/exits64/mqcci_licenses.ini
• For IBM i: /QIBM/UserData/mqm/mqcci/mqcci_licenses.ini

 UsePureCSV specifies that MQCCI should also create the CSV record as a pure CSV record. 
It supports 2 values [Y / N].  The default value is N.

 AddDiscMessage specifies that MQCCI should also create a CSV record when the application 
disconnects from the queue manager. It supports 2 values [Y / N].  The default value is N.

 IncludeTag specifies whether or not MQCCI will include a 16 character tag on both the 
"CONN" and "DISC" records.  The default value is Yes.  Note: Only used if AddDiscMessage is set to 
'Y'.

 IncludeDurationTime specifies whether or not MQCCI will include the duration time on the 
"DISC" record. The default value is No.  Note: Only used if AddDiscMessage is set to 'Y'.
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4.1.2 CSV Data to a File
This section describes the keywords related to CSVFile handling.

 CSVFile specifies the location of the CSV file. The default is as follows:

For Windows:
CSVFile=C:\Capitalware\MQCCI\%QM%-%DATE%.csv

For IBM MQ 32-bit on Linux:
CSVFile=/var/mqm/exits/%QM%-%DATE%.csv

For IBM MQ 64-bit on Unix and Linux:
CSVFile=/var/mqm/exits64/%QM%-%DATE%.csv

For IBM MQ  on IBM i:
CSVFile=/QIBM/UserData/mqm/mqcci/%QM%-%DATE%.csv

4.1.3 CSV Data to a Queue
This section describes the keywords related to directing the audit data to an CSV Queue.

 UseCSVQueue controls the use of CSVQueue.  Set to Y to activate feature.

 CSVQueue is either a local or remote queue of where the audit data is to be outputted to.

4.1.4 Logging
This section describes the keywords related to logging and their values.

 LogMode specifies what type of logging the user wishes to use. LogMode supports 4 values: Q
(Quiet), N (Normal), V (Verbose) and D (Debug). The default value is N. 

 LogFile specifies the location of the log file. The default values are as follows: 
• For Windows: C:\Capitalware\MQCCI\mqcci.log 
• For IBM MQ 32-bit on Linux: /var/mqm/exits/mqcci.log 
• For IBM MQ 64-bit on Unix and Linux: /var/mqm/exits64/mqcci.log
• For IBM I: /QIBM/UserData/mqm/mqcci/mqcci.log

 
 RotateLogDaily specifies whether or not the daily log file rotation should take place.  The 
default value is Y (Yes).

 BackupLogFileCount specifies the number of backup log files to be kept / retained by 
MQCCI.  The default value is 9.
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4.2 Show Structures Tab
This section will describe various parameters on the Show Structures tab of a MQCCI IniFile. 

The following is the Show Structures Tab with sample values: 
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The parameters on the Show Structures Tab are as follows: 

 ShowCD specifies the MQCD (Channel Definition) fields of the MQCONN / MQCONNX API 
calls that the user wants MQCCI to generate in the audit information.

 ShowCXP specifies the MQCD (Channel Exit Parameters) fields of the MQCONN / 
MQCONNX API calls that the user wants MQCCI to generate in the audit information. 
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5 Other Tools
This chapter will describes how the other tools included with MQCCI-GUI.

5.1 Hex Converter
This section will describe how to invoke and use the Hex Converter tool. Hex Converter tool can 
convert a hexadecimal number to its corresponding string representation and vice versa. i.e. 
0x'3132333041424344' to '1230ABCD'.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCCI-GUI.

From the main panel of MQCCI-GUI, select Tools, then Hex Converter.

This is the main panel of the Hex Converter.

• The user first selects the Conversion type: "Hex to Character" or "Character to Hex"
• Input the value hex or character value into the "Input Value" field
• Click the Convert button to convert the data
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5.2 Hex Editor
This section will describe how to invoke and use the Hex Editor tool. The Hex Editor is a simple 
multipurpose hex editor. The Hex Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCCI-GUI.

From the main panel of MQCCI-GUI, select Tools, then Hex Editor.

This is the main panel of the Hex Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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5.3 Tail File
This section will describe how to invoke and use the Tail File tool. The Tail File is a simple 
multipurpose file monitoring viewer. The Tail File supports monitoring of multiple files at the same 
time.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCCI-GUI.

From the main panel of MQCCI-GUI, select Tools, then Tail File.

This is the main panel of the Tail File and it has 3 open files.

Supported features:
• Opening of multiple files
• Wrap Text and Recent File List
• Copy, Find, Find Next and Print
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5.4 Text Editor
This section will describe how to invoke and use the Text Editor tool. The Text Editor is a simple 
multipurpose plain-text editor. The Text Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCCI-GUI.

From the main panel of MQCCI-GUI, select Tools, then Text Editor.

This is the main panel of the Text Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Builtin XML Viewer, Wrap Text
• Recent File List
• Cut, Copy, Paste, Find and Find Next
• Save, Save As and Print
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The following shows the Text Editor's builtin XML Viewer.

MQCCI-GUI User Guide          Page 18



5.5 Visual Difference
This section will describe how to invoke and use the Visual Difference tool. The Visual Difference is a
simple file to file comparison tool.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCCI-GUI.

From the main panel of MQCCI-GUI, select Tools, then Visual Difference.

This is the main panel of the Visual Difference. To initiate the file comparison process, click File and 
then click Compare File to File

First the user needs to select the first file for the comparison.
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Next, the user needs to select the second file for the comparison.

The following shows the difference between 2 files. Differences are highlighted: Green for inserts, Red
for deletions and Blue for changes.
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5.6 XML Editor
This section will describe how to invoke and use the XML Editor tool. The XML Editor is a simple 
multipurpose plain-text editor. The XML Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQCCI-GUI.

From the main panel of MQCCI-GUI, select Tools, then XML Editor.

This is the main panel of the XML Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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6 Miscellaneous
This chapter will describes how the miscellaneous features of MQCCI-GUI.

6.1 Language
This section will describe how to switch MQCCI-GUI's Language Text to another Language Text. 
MQCCI-GUI has been designed to support Java's multi-language environment.  Currently, MQCCI-
GUI has language support (menu items, buttons and titles) for the following 55 languages:

 Amharic (am)
 Arabic (ar)
 Azerbaijani (az)
 Bengali (bn)
 Cebuano (ceb)
 Chinese (China) (zh)
 Chinese (Taiwan) (zh)
 Czech (cs)
 Danish (da)
 Dutch (nl)
 English (en)
 Finnish (fi)
 French (fr)
 German (de)
 Greek (el)
 Gujarati (gu)
 Hausa (ha)
 Hebrew (iw)
 Hindi (hi)

 Hungarian (hu)
 Igbo (ig)
 Indonesian (in)
 Italian (it)
 Japanese (ja)
 Javanese jv)
 Kannada (kn)
 Korean (ko)
 Malay (ms)
 Malayalam (ml)
 Marathi (mr)
 Norwegian (no)
 Panjabi (pa)
 Pashto (ps)
 Persian (fa)
 Polish (pl)
 Portuguese (pt)
 Romanian (ro)
 Russian (ru)

 Shona (sn)
 Sindhi (sd)
 Spanish (es)
 Sundanese (su)
 Swahili (sw)
 Swedish (sv)
 Tamil (ta)
 Telugu (te)
 Thai (th)
 Turkish (tr)
 Ukrainian (uk)
 Urdu (ur)
 Uzbek (uz)
 Vietnamese (vi)
 Xhosa (xh)
 Yoruba (yo)
 Zulu (zu)

From the main panel of MQCCI-GUI, select View, then Language.
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6.2 Reset View
This section will describe how to reset the view of MQCCI-GUI if the display is not correct.

The user can also reset the view from the command line by passing in the RG parameter.

6.2.1 Windows Command Line
On Windows, issue the following command to reset the view of MQCCI-GUI:

mqccigui.exe  RG

6.2.2 Linux and macOS Command Line
On Linux and macOS, issue the following command to reset the view of MQCCI-GUI:

./mqccigui.sh  RG
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7 Appendix A – Frequently Asked Questions (FAQ)

Q. Can IniFiles be create on Windows for MQCCI on Unix?
A. Yes. Once the IniFile has been saved, the user can copy or ftp (in ASCII mode) 
the file to the remote server.
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8 Appendix B – MQCCI-GUI Upgrade Procedures
To upgrade an existing installation of MQCCI-GUI, please do the following in the appropriate section 
below.

8.1 Windows Upgrade
 Stop all instances of  MQCCI-GUI
 Backup any MQCCI-GUI data files in the MQCCI-GUI install directory
 Go to the Windows Control Panel and select Program and Features
 Select MQCCI-GUI and then click the Uninstall button
 Run the install program called: mqccigui-setup-withjre.exe
 The installer follows the standard Windows install procedures and provides default values for 

the user.
 When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQCCI-GUI.
 Restore the MQCCI-GUI data files if necessary
 To run MQCCI-GUI, select the MQCCI-GUI icon from within the MQCCI-GUI folder.

8.2 Linux or macOS Upgrade
 Stop all instances of  MQCCI-GUI
 Backup any MQCCI-GUI data files in the MQCCI-GUI install directory
 Remove the installation i.e. rm -Rf Capitalware/MQCCI-GUI/
 Unzip the file, open a shell prompt and execute the following commands: 

unzip mqccigui.zip 

 When the unzip command has finished, there should be a directory tree as follows: 

Capitalware/MQCCI-GUI 

 Change directory by typing the following:

cd Capitalware/MQCCI-GUI 

 Before running MQCCI-GUI for the first time, you need to add the execute attribute to the 
mqccigui.sh shell scripts. Type the following: 

chmod +x mqccigui.sh 

 To run MQCCI-GUI from the Capitalware/MQCCI-GUI directory, then type the following: 

 ./mqccigui.sh
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9 Appendix C – Support
The support for MQCCI-GUI can be found at the following location:

By email at:
support@capitalware.com

By regular mail at:

Capitalware Inc.
Attn: MQCCI-GUI Support
Unit 11, 1673 Richmond Street, PMB524
London, Ontario  N6G2N3
Canada
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10 Appendix D – Summary of Changes

 MQCCI-GUI v1.2.0
o Rearranged the fields on the General tab.

 MQCCI-GUI v1.1.0
o Added support for IncludeTag keyword
o Added support for IncludeDurationTime keyword
o Added the ‘Recent Files’ menu option under the File menu option.
o Added images to buttons for more user-friendly display.
o Added support for 55 languages for the menu options, buttons and titles (not IniFile 

keywords).
o Added the ‘Reset View’ menu option under the View menu option.
o Added 6 tools under the Tools menu option: 

 Compare File to a File
 Hex Converter
 Hex Editor
 Tail File
 Text Editor
 XML Editor

 MQCCI-GUI v1.0.0
o Initial release.
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11 Appendix E – License Agreement
This is a legal agreement between you (either an individual or an entity) and Capitalware Inc. By 
opening the sealed software packages (if appropriate) and/or by using the SOFTWARE, you agree to 
be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly 
return the disk package and accompanying items for a full refund.
SOFTWARE LICENSE

1. GRANT OF LICENSE. This License Agreement (License) permits you to use one copy of the 
software product identified above, which may include user documentation provided in on-line or 
electronic form (SOFTWARE). The SOFTWARE is licensed as a single product, to an individual 
queue manager, or group of queue managers for an Enterprise License. This Agreement requires that 
each queue manager of the SOFTWARE be Licensed, either individually, or as part of a group.  Each 
queue manager's use of this SOFTWARE must be covered either individually, or as part of an 
Enterprise License. The SOFTWARE is in use on a computer when it is loaded into the temporary 
memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk) of that computer. This 
software may be installed on a network provided that appropriate restrictions are in place limiting the 
use to registered queue managers only.  Each licensed queue manager will be provided with a perpetual
license key and the licensee may continue to use the SOFTWARE, so long as the licensee is current on
the Yearly Maintenance Fee.  If the licensee stops paying the Yearly Maintenance Fee, then the 
SOFTWARE must be removed from all systems at the end of the current maintenance period.

2. COPYRIGHT. The SOFTWARE is owned by Capitalware Inc. and is protected by United States Of 
America and Canada copyright laws and international treaty provisions. You may not copy the printed 
materials accompanying the SOFTWARE (if any), nor print copies of any user documentation 
provided in on-line or electronic form. You must not redistribute the registration codes provided, either
on paper, electronically, or as stored in the files mqcci.ini, mqcci_licenses.ini or any other form.

3. OTHER RESTRICTIONS. The registration notification provided, showing your authorization code 
and this License is your proof of license to exercise the rights granted herein and must be retained by 
you. You may not rent or lease the SOFTWARE, but you may transfer your rights under this License 
on a permanent basis, provided you transfer this License, the SOFTWARE and all accompanying 
printed materials, retain no copies, and the recipient agrees to the terms of this License. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE, except to the extent the foregoing 
restriction is expressly prohibited by applicable law.

LIMITED WARRANTY

LIMITED WARRANTY. Capitalware Inc. warrants that the SOFTWARE will perform substantially 
in accordance with the accompanying printed material (if any) and on-line documentation for a period 
of 365 days from the date of receipt.

CUSTOMER REMEDIES. Capitalware Inc. entire liability and your exclusive remedy shall be, at 
Capitalware Inc. option, either (a) return of the price paid or (b) repair or replacement of the 
SOFTWARE that does not meet this Limited Warranty and that is returned to Capitalware Inc. with a 
copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from 
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accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder 
of the original warranty period or thirty (30) days, whichever is longer.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, Capitalware Inc. 
disclaims all other warranties, either express or implied, including but not limited to implied warranties
of merchantability and fitness for a particular purpose, with respect to the SOFTWARE and any 
accompanying written materials.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall Capitalware Inc. be liable for any damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use the SOFTWARE, even if 
Capitalware Inc. has been advised of the possibility of such damages.
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12 Appendix F – Notices

Trademarks:

AIX, IBM, MQSeries, OS/2 Warp, OS/400, iSeries, MVS, OS/390, WebSphere, IBM MQ and z/OS 
are trademarks of International Business Machines Corporation.

HP-UX is a trademark of Hewlett-Packard Company.

Intel is a registered trademark of Intel Corporation.

Java, J2SE, J2EE, Sun and Solaris are trademarks of Sun Microsystems Inc.

Linux is a trademark of Linus Torvalds.

Mac OS X is a trademark of Apple Computer Inc.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation.

UNIX is a registered trademark of the Open Group.

WebLogic is a trademark of BEA Systems Inc.
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